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Préface

Le moteur de jeu Unity est un choix incroyablement puissant et populaire auprès des déve-

loppeurs de jeux, qu’ils soient des professionnels ou des amateurs. L’objectif de cet ouvrage 

est de permettre aux lecteurs de se familiariser avec Unity le plus rapidement possible (en 

24  heures environ), tout en présentant les principes fondamentaux du développement de 

jeux. Contrairement à d’autres livres qui traitent uniquement de sujets spécifiques ou passent 

leur temps à enseigner la création d’un seul jeu, celui-ci couvre un large éventail de sujets et 

propose même quatre jeux. Quelle bonne affaire ! Lorsque vous aurez terminé la lecture de 

ce livre, vous aurez non seulement des connaissances théoriques sur le moteur de jeu Unity, 

mais également plusieurs jeux pour les accompagner.

Tous les éléments de code utilisés dans cet ouvrage sont disponibles sur GitHub, à l’adresse 

https://fixbyproximity.com/Downloads/UnityBook.html, ou sur le site Dunod, à l’adresse : 

https://www.dunod.com/ean/9782100862696.
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Au programme de cette session :

	X Installer Unity.

	X Créer un nouveau projet ou ouvrir un projet existant.

	X Employer l’éditeur Unity.

	X Naviguer au sein du panneau Scene de Unity.

L’objectif de cette première session est de vous préparer à entrer dans l’environnement Unity. 

Vous découvrirez tout d’abord les différentes licences Unity, puis vous installerez celle que 

vous aurez choisie. Vous apprendrez également à créer de nouveaux projets et à ouvrir des 

projets existants. Vous lancerez le puissant éditeur Unity et examinerez ses différents compo-

sants. Enfin, vous apprendrez à naviguer dans une scène à l’aide de la souris et du clavier. 

Cette leçon se veut pratique, alors téléchargez Unity tout en la lisant et suivez les instructions.

Installer unity
Avant de pouvoir utiliser Unity, vous devez commencer par le télécharger et l’installer. 

Aujourd’hui, l’installation d’un logiciel se fait de manière plutôt simple et celle de Unity 

n’échappe pas à cette règle. Toutefois, avant d’installer quoi que ce soit, vous devez choisir 

la version de Unity qui vous correspond parmi les offres proposées : Étudiants, Personal, Pro, 

Enterprise et Industry. La version Personal est gratuite et comprend tout ce dont vous avez 

besoin pour mettre en œuvre tous les exemples et projets décrits dans cet ouvrage. En réalité, 

elle permet même de créer des jeux commerciaux, sous conditon que votre chiffre d’affaires 

annuel soit inférieur à 100 000 dollars ! Si vous avez la chance de gagner un montant supé-

rieur, ou si vous souhaitez disposer des fonctionnalités avancées des versions Pro, Enterprise 

ou Industry (principalement destinées aux équipes et aux grands comptes), vous pourrez 

toujours procéder à une mise à niveau de votre licence.

HEURE 1
Introduction à unity
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2 HEurE 1. Introduction à Unity

NOTE

Hub unity
À partir du site web de Unity, vous devez télécharger et installer le Hub Unity. Il s’agit d’une plate-
forme qui centralise toutes les installations et projets réalisés à l’aide de l’éditeur Unity (c’est 
cet éditeur qui vous permettra de créer des jeux). Si vous lisez cet ouvrage alors que vous avez 
déjà employé une version précédente de Unity qui ne disposait pas du Hub, ne vous inquiétez 
pas. Les concepts sous-jacents aux installations et aux projets Unity n’ont pas changé. Comme 
le dirait la publicité, « nouvel emballage, mais toujours le même goût délicieux ! ».

NOTE

Mises à jour de unity
Le Hub et l’éditeur Unity sont des logiciels en constante évolution et de nouvelles versions 
peuvent sortir. Les illustrations et les instructions présentes dans cet ouvrage correspondent à 
la version disponible au moment de l’écriture de ces lignes, mais peuvent être différentes de ce 
que vous verrez sur votre écran. Bien que des détails spécifiques du logiciel sont susceptibles 
de changer, les étapes et les concepts généraux décrits dans cet ouvrage resteront justes et 
pertinents.

Télécharger et installer le Hub unity
Nous l’avons mentionné précédemment, le point de départ à tout développement de jeux 

avec Unity est le Hub Unity. Si vous êtes prêt à télécharger et à installer le Hub Unity, procé-

dez de la manière suivante :

 1. Rendez-vous sur le site web de Unity, à l’adresse https://unity.com/fr. Cliquez sur le 

bouton Télécharger, puis sur le bouton de téléchargement qui s’affiche.

 2. Lancez le programme d’installation et suivez les instructions qui sont données.

 3. Au terme de l’installation, ouvrez l’application Unity Hub. S’il s’agit de votre première 

utilisation de l’application, il vous sera demandé de vous connecter ou de créer un 

nouveau compte (puisque la procédure est rapide et que le compte sera indispensable 

par la suite, procédez à sa création dès à présent). Vous avez également la possibilité 

d’installer directement l’éditeur Unity, de choisir votre licence et de modifier l’appa-

rence de la fenêtre. Sautez ces étapes pour le moment, mais vous pouvez basculer dans 

un affichage clair si vous le souhaitez. Vous devriez alors voir apparaître une fenêtre 

semblable à celle de la figure 1.1.

En plus d’être le centre à partir duquel vous allez gérer tous vos projets et installations, le Hub 

Unity vous permet également d’accéder aux nouvelles de la communauté et de consulter des 

ressources d’apprentissage qui vous aideront dans vos développements.
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Installer Unity 3

FIGURE 1.1
Le Hub Unity.

NOTE

Liens Internet
Toutes les URL Internet données dans cet ouvrage sont valides au moment de l’écriture de ces 
lignes. Les emplacements web peuvent toutefois changer. Si ce que vous recherchez n’est plus 
disponible au travers des liens proposés, servez-vous de votre moteur de recherche préféré pour 
trouver leur nouvel emplacement.

Installer l’éditeur unity
Le centre de contrôle étant à présent installé, vous pouvez procéder à l’installation de l’édi-

teur Unity. À l’aide du Hub, vous avez la possibilité d’ajouter autant de versions de Unity 

que vous le souhaitez (sous condition d’avoir la place disponible sur votre disque dur). Voici 

comment procéder :

 1. Dans le Hub, cliquez sur Installs, puis sur le bouton Install Editor.

 2. Dans la liste qui s’affiche, cliquez sur le bouton Install associé à la version LTS 2022 

(voir figure 1.2). (La note « Pourquoi la version LTS 2022 ? » explique les raisons de ce 

choix.)
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4 HEurE 1. Introduction à Unity

FIGURE 1.2
Choisir la version LTS 2022 en cliquant sur son bouton Install.

 3. Dans la fenêtre suivante, vous pouvez sélectionner les compléments et les plateformes 

de destination que vous souhaitez prendre en charge (voir figure 1.3). Faites vos choix 

dès à présent si vous le souhaitez, mais ce n’est pas une obligation dans le cadre de cet 

ouvrage. Vous pourrez revenir ultérieurement sur vos décisions et ajouter de nouveaux 

éléments. Pour le moment, conservez la sélection par défaut et cliquez sur Continue.

FIGURE 1.3
Modules supplémentaires disponibles.

 4. Acceptez l’accord de licence de Visual Studio, puis cliquez sur Install.

 5. Vous n’avez plus qu’à attendre la fin de l’installation.
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Installer Unity 5

NOTE

Pourquoi la version LTS 2022 ?
Vous vous demandez peut-être pourquoi installer la version 2022 du logiciel et ce que signifie 
LTS. Parmi les différentes versions de Unity, la version LTS (pour Long Term Support, ou support 
à long terme) est celle qui réunit toutes les fonctionnalités précédentes, qui est parfaitement 
stable et qui sera supportée pendant au moins les deux prochaines années. En général, la 
version LTS du moteur ne sort pas avant le début de l’année suivante. La version LTS 2022 de 
Unity est donc arrivée début 2023 et est la plus récente au moment de l’écriture de ces lignes.

NOTE

Systèmes d’exploitation et matériels pris en charge
Pour utiliser Unity, vous devez disposer d’un ordinateur fonctionnant sous Windows, macOS ou 
Linux. Il doit également satisfaire aux contraintes matérielles minimales suivantes (pour plus de 
précisions, consultez la documentation de Unity) :

	X Windows 7 SP1+, Windows 10 ou Windows 11, versions 64 bits seulement  ; macOS X 
10.14+ ; Ubuntu 18.04 ou 20.04 ;

	X une carte graphique avec capacités DX10, DX11 ou DX12 ;

	X un processeur X64 qui prend en charge le jeu d’instructions SSE2 (la plupart des proces-
seurs modernes) ou un processeur Apple M1.

Activer une licence
Avant de pouvoir employer l’éditeur Unity, vous devez activer une licence. Pour cela, cliquez 

sur le bouton Manage licenses (voir figure 1.1) et, dans la fenêtre qui s’affiche, cliquez sur 

Add license. La liste des licences disponibles apparaît. Choisissez Get a free personal license,  

puis acceptez l’accord de licence après l’avoir lu. Vous pouvez terminer en fermant la fenêtre 

qui récapitule les licences installées (voir figure 1.4).

FIGURE 1.4
La licence Personal a été ajoutée.
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6 HEurE 1. Introduction à Unity

Découvrir l’éditeur unity
Vous avez installé Unity, vous pouvez donc commencer à explorer son éditeur. Il s’agit d’un 

composant visuel qui vous permet de développer des jeux de façon WYSIWYG (acronyme de 

« what you see is what you get », signifiant littéralement « ce que vous voyez est ce que vous 

obtenez »). Puisque la plupart des interactions se feront avec l’éditeur, nombreux sont ceux 

qui le désignent simplement sous le nom Unity. Cette section présente les différents consti-

tuants de l’éditeur Unity et comment ils se combinent pour créer des jeux.

rubrique Projects
Le Hub Unity permet non seulement de gérer les installations de l’éditeur, mais également 

de créer et de sélectionner des projets. À ce stade, la rubrique Projects de votre Hub est certai-

nement vide (voir figure 1.5).

FIGURE 1.5
La rubrique Projects vide dans le Hub.

Pour créer un nouveau projet, vous devez simplement cliquer sur le bouton New project. Si 

vous avez installé plusieurs versions de l’éditeur, vous pouvez choisir celle que vous souhai-

tez utiliser dans la boîte de dialogue qui s’affiche alors. Pour ouvrir un projet existant mais 

absent de la liste, cliquez sur le bouton Open. La mise en pratique suivante détaille la créa-

tion d’un nouveau projet.
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Découvrir l’éditeur Unity 7

▼ À VOUS DE JOUER

Créer un premier projet

Vous êtes prêt à créer un projet. Notez bien l’endroit où vous enregistrez le projet afin de 
pouvoir le retrouver ensuite plus facilement. La figure 1.6 montre la boîte de dialogue utilisée 
pour créer un projet. Voici les étapes à suivre :

 1. Ouvrez le Hub Unity et cliquez sur New project. La boîte de dialogue New project s’af-
fiche.

 2. Choisissez un emplacement pour votre projet. Nous vous conseillons de créer un dos-
sier nommé Projets Unity afin d’y placer tous ceux proposés dans cet ouvrage. Si vous 
hésitez sur le meilleur emplacement, vous pouvez conserver celui par défaut.

 3. Nommez le projet Heure 1 AVDJ. Unity crée un dossier de même nom que le projet, 
à l’emplacement indiqué dans la boîte de dialogue.

 4. Pour le moment, gardez la sélection 3D. Nous reviendrons ultérieurement sur les autres 
options.

 5. Cliquez sur Create project.

FIGURE 1.6
Les paramètres de configuration du premier projet.

NOTE

2D, 3D, pipelines de rendu ?
Vous vous interrogez peut-être sur l’intérêt des autres options (templates). Les boutons 2D et 
3D correspondent au type de jeu que vous prévoyez de créer. Ne craignez pas de faire le mau-
vais choix, car ces options contrôlent uniquement les paramètres de l’éditeur, qui peuvent être 
modifiés à tout moment. Les options pour le pipeline de rendu (HDRP, High Definition RP, et URP, 
Universal Render Pipeline) font partie du SRP de Unity (Scriptable Rendering Pipeline, ou pipeline 
de rendu programmable), qui donne aux développeurs un contrôle poussé sur le rendu de leurs 
projets, mais exige des connaissances qui sortent du cadre de cette session.
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Interface de unity
À ce stade, vous avez donc installé Unity et découvert la boîte de dialogue New Project. Il 

est temps à présent d’aller plus loin et de commencer à manipuler l’éditeur. Lorsque vous 

ouvrez un nouveau projet Unity, vous obtenez un ensemble de fenêtres grises (ou panneaux) 

et tout semble relativement vide (voir figure 1.7). N’ayez crainte, tout cela s’animera bien-

tôt. Les sections suivantes présentent chaque panneau, tour à tour. Examinons tout d’abord 

l’organisation générale.

FIGURE 1.7
L’interface de Unity.

Pour commencer, Unity offre la possibilité de définir la manière dont vous souhaitez travail-

ler. Tous les panneaux peuvent être déplacés, ancrés, dupliqués ou modifiés. Par exemple, 

si vous cliquez sur le mot Hierarchy (situé en partie gauche) pour sélectionner ce panneau 

et le déplacez au-dessus du panneau Inspector (situé en partie droite), vous regroupez ces 

deux fenêtres sous forme d’onglets. Vous pouvez également placer le curseur de la souris sur 

les lignes qui séparent les panneaux afin de les redimensionner. Le mieux serait que vous 

preniez un petit moment pour vous familiariser avec cette interface et que vous placiez les 

panneaux en fonction de vos préférences. Si l’organisation construite ne vous satisfait pas, 

vous pouvez revenir facilement et rapidement à la disposition par défaut en cliquant sur 

Window > Layouts > Default. Vous pouvez également essayer les dispositions prédéfinies (la 

disposition Wide est assez intéressante). Si vous créez un agencement qui vous convient, vous 

pouvez le sauvegarder en cliquant sur Window > Layouts > Save Layout (pour l’écriture de 

cet ouvrage, j’ai créé une disposition particulière que j’ai nommée Dunod). Par la suite, si 

vous modifiez l’organisation de l’interface, vous pourrez revenir aisément à la version enre-

gistrée. Vous pouvez également gérer les agencements à l’aide de la liste déroulante Layouts 

située dans l’angle supérieur droit de l’éditeur.
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NOTE

Trouver la bonne disposition
Les gens ne se ressemblant pas, il n’existe donc aucune disposition idéale. Le meilleur agence-
ment sera celui qui vous aidera à travailler sur vos projets et qui vous facilitera la vie. Prenez le 
temps de jouer avec la disposition des panneaux afin de trouver celle qui convient. Les manipu-
lations dans Unity seront nombreuses et il est préférable que vous disposiez d’un environnement 
confortable.

Dupliquer un panneau est également très simple. Il suffit de cliquer du bouton droit sur 

l’onglet de n’importe quel panneau (comme celui de l’inspecteur, voir figure 1.8), d’ouvrir le 

menu Add Tab et de choisir le panneau dans la liste qui apparaît. Mais pourquoi vouloir 

dupliquer un panneau ? Supposons que, au cours du déplacement frénétique d’un panneau, 

vous le fermiez par mégarde. En ajoutant de nouveau l’onglet, vous retrouvez l’accès à ce 

panneau. De même, vous pouvez envisager de créer plusieurs vues Scene, chacune alignée 

avec un élément ou un axe spécifique dans votre projet. Pour voir cela en action, choisissez la 

disposition prédéfinie 4 Split en sélectionnant Window > Layouts > 4 Split. (Si vous avez déjà 

créé l’agencement qui vous convient, n’oubliez pas de le sauvegarder avant de choisir 4 Split.)

FIGURE 1.8
Ajouter un nouvel onglet.

Sans plus tarder, examinons les différents panneaux de l’éditeur Unity.

Panneau Project
Tout ce qui est créé pour un projet (fichiers, scripts, textures, modèles, etc.) se retrouve dans le 

panneau Project (voir figure 1.9). Cette fenêtre montre toutes les ressources (assets) et l’orga-

nisation d’un projet. Lorsque vous créez un nouveau projet, vous obtenez un nouveau dossier 

nommé Assets. Si vous examinez l’emplacement dans lequel vous avez enregistré le projet 

sur votre disque dur, vous trouvez également le dossier Assets. En effet, le panneau Project 

est un miroir du contenu des dossiers présents sur le disque dur. Si vous créez un fichier ou 
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Si vous ouvrez un dossier dans le panneau Project, son contenu s’affiche dans la rubrique 

Assets située à droite. La figure 1.9 montre que la rubrique Assets contient un seul dossier 

nommé Scenes. En ouvrant celui-ci, vous obtenez son contenu, une seule scène, affiché dans 

la partie droite. Pour créer des ressources, cliquez simplement sur la liste déroulante Create 

(représentée par le signe +). Le menu qui s’affiche permet d’ajouter différentes sortes de 

 ressources et de dossiers à un projet.

ASTUCE

Organisation d’un projet
L’organisation est extrêmement importante dans la gestion d’un projet. Plus vos projets seront 
complexes, plus le nombre de ressources augmentera. Retrouver quelque chose peut finir par 
devenir difficile. Pour éviter toute frustration, suivez quelques règles d’organisation simples :

	X chaque type de ressources (scènes, scripts, textures, etc.) doit avoir son propre dossier ;

	X chaque ressource doit se trouver dans un dossier ;

	X si vous imbriquez des dossiers, assurez-vous que la structure a un sens. Les dossiers 
doivent devenir plus spécifiques et ne doivent pas être vagues ou généraux.

Suivre ces quelques règles fera une grande différence.

Les boutons Favorites permettent de sélectionner rapidement toutes les ressources d’un cer-

tain type. Ils fournissent une forme d’aperçu des ressources. En cliquant sur l’un de ces bou-

tons, par exemple All Models, ou en effectuant une recherche, vous pouvez obtenir une liste 

de ressources et de packages plus ciblée (voir figure 1.10). Avec un peu de pratique, trouver 

exactement ce que vous recherchez deviendra très facile.

Recherche dans les packages, 
les ressources ou les deux

Boutons Favorites Recherche de ressources 
avec le terme « scene »

FIGURE 1.10
Une recherche dans le panneau Project.
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un dossier dans Unity, le fichier ou le dossier correspondant apparaît dans l’explorateur (et 

vice versa). Vous pouvez déplacer les éléments contenus dans le panneau Project simplement 

en les faisant glisser. Unity vous permet de placer des éléments à l’intérieur des dossiers et de 

réorganiser votre projet à la volée.

Création rapide Champ de recherche

Panneau des 
ressources

Dossier des 
packages

Dossier des 
ressources

FIGURE 1.9
Le panneau Project.

NOTE

ressources et objets
Une ressource (asset) correspond à tout élément qui existe sous forme de fichier dans le dossier 
Assets. Par exemple, les textures, les maillages, les fichiers audio et les scripts sont des res-
sources. Un objet de jeu (game object) est un objet qui fait partie d’une scène ou d’un niveau. 
Vous pouvez créer des ressources pour les objets de jeu et vous pouvez créer des objets de jeu 
à partir des ressources.

NOTE

Packages
Le dossier Packages est une rubrique spéciale qui recense les packages ajoutés au projet. Un 
package est une sorte de complément ou de module qui permet de modifier les fonctionnalités 
d’un projet. Unity en propose plusieurs et vous pouvez également créer les vôtres. Nous y revien-
drons ultérieurement, lorsque nous aurons besoin des packages.

ATTENTION

Déplacement des ressources
Unity conserve des liens entre les différentes ressources associées à un projet. Par conséquent, 
déplacer des éléments en dehors de Unity ou les supprimer risque de provoquer des problèmes. 
De façon générale, il est préférable de gérer les ressources uniquement depuis l’éditeur Unity.
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Une ressource (asset) correspond à tout élément qui existe sous forme de fichier dans le dossier 
Assets. Par exemple, les textures, les maillages, les fichiers audio et les scripts sont des res-
sources. Un objet de jeu (game object) est un objet qui fait partie d’une scène ou d’un niveau. 
Vous pouvez créer des ressources pour les objets de jeu et vous pouvez créer des objets de jeu 
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Packages
Le dossier Packages est une rubrique spéciale qui recense les packages ajoutés au projet. Un 
package est une sorte de complément ou de module qui permet de modifier les fonctionnalités 
d’un projet. Unity en propose plusieurs et vous pouvez également créer les vôtres. Nous y revien-
drons ultérieurement, lorsque nous aurons besoin des packages.
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Déplacement des ressources
Unity conserve des liens entre les différentes ressources associées à un projet. Par conséquent, 
déplacer des éléments en dehors de Unity ou les supprimer risque de provoquer des problèmes. 
De façon générale, il est préférable de gérer les ressources uniquement depuis l’éditeur Unity.
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Panneau Inspector
Le panneau Inspector affiche toutes les propriétés de l’élément sélectionné. Cliquez simple-

ment sur une ressource ou un objet dans le panneau Project ou Hierarchy pour que le pan-

neau Inspector se remplisse automatiquement de toutes les informations.

La figure 1.12 montre le panneau Inspector après la sélection de l’objet Main Camera dans 

la fenêtre Hierarchy.

Listes déroulantes

Nom

Composants

FIGURE 1.12
Le panneau Inspector.

Examinons quelques-unes des fonctionnalités proposées par le panneau Inspector :

	X Décocher la case placée à gauche du nom de l’objet désactive celui-ci et le masque dans 

la scène. Les objets sont actifs par défaut (leur case est cochée).

	X Les listes déroulantes, comme Tag et Layer, sur lesquelles nous reviendrons plus loin, 

permettent de faire un choix parmi les options prédéfinies.

	X Il est possible de modifier les valeurs des zones de texte, des listes déroulantes et des 

curseurs. Les changements sont propagés automatiquement et immédiatement dans la 

scène, même si le jeu est en cours d’exécution.
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Panneau Hierarchy
D’une certaine manière, le panneau Hierarchy (voir figure 1.11) ressemble énormément au 

panneau Project. Cependant, il montre tous les éléments non pas du projet complet mais de 

la scène courante. Lorsque vous créez un projet avec Unity, vous obtenez la scène par défaut, 

qui comprend deux éléments  : les objets Main Camera (caméra principale) et Directional 

Light (éclairage directionnel). Au fur et à mesure que vous ajoutez des éléments à une scène, 

ils apparaissent dans le panneau Hierarchy. Comme avec le panneau Project, vous pouvez 

vous servir du menu Create pour ajouter rapidement des éléments à une scène, effectuer 

une recherche depuis le champ de recherche et déplacer des éléments pour les organiser et 

les imbriquer.

Création rapide Champ de recherche

Objet de jeu

Objet imbriqué

FIGURE 1.11
Le panneau Hierarchy.

ASTUCE

Imbrication
L’imbrication est une manière d’établir une relation entre deux ou plusieurs éléments. Dans le 
panneau Hierarchy, faire glisser un élément sur un autre imbrique le premier sous le second. 
Cela crée une relation parent/enfant très souvent employée. Dans ce cas, l’objet supérieur est 
le parent, tous les objets en dessous sont ses enfants. Le décalage permet de savoir qu’un 
objet est imbriqué. Vous le verrez plus loin, l’imbrication des objets dans le panneau Hierarchy 
peut affecter leur comportement.

ASTUCE

Scènes
Dans Unity, une scène décrit ce que vous connaissez peut-être déjà sous l’appellation niveau ou 
carte. Au fur et à mesure du développement d’un projet Unity, chaque collection d’objets et de 
comportements doit se trouver dans sa propre scène. Par exemple, si vous construisez un jeu 
avec un niveau « neige » et un niveau « jungle », chacun doit correspondre à une scène distincte. 
Lors de vos recherches sur Internet, vous constaterez que les termes scène (scene) et niveau 
(level) sont employés de façon interchangeable.
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	X Éclairage de la scène  : ce bouton détermine si les objets présents dans le panneau 

Scene sont éclairés par une lumière d’ambiance par défaut ou uniquement par les 

lumières qui existent réellement dans la scène. L’éclairage d’ambiance intégré est 

activé par défaut.

	X Mode d’audition  : ce bouton permet d’indiquer si une source audio opère dans la 

fenêtre Scene.

	X Effets visuels : ce menu permet d’ajouter des effets dans la scène, comme un ciel (sky-

box), du brouillard et d’autres.

	X Objets cachés  : ce bouton active ou désactive la visibilité des objets cachés dans le 

panneau Scene.

	X Grille de la scène : ce menu permet de configurer la grille de la scène.

	X Caméra de la scène : ce menu permet de configurer la caméra de la scène (celle utilisée 

pour visualiser la scène pendant l’édition).

	X Sélecteur de gizmo : ce menu permet de choisir les gizmos, c’est-à-dire les indicateurs 

facilitant le débogage visuel et la configuration, qui apparaissent dans le panneau 

Scene. Il détermine également l’affichage de la grille de placement.

	X Gizmo de la scène  : ce contrôle montre la direction dans laquelle vous regardez et 

aligne le panneau Scene selon un axe.

	X Outils de transformation  : les boutons du panneau Tools permettent de manipuler 

les objets de jeu et seront détaillés dans des sessions ultérieures. Notez le bouton dont 

l’icône ressemble à une main, car nous le décrirons plus loin dans cette session.

	X Bascules du gizmo de transformation : ces bascules permettent de préciser comment les 

gizmos apparaissent dans le panneau Scene. Vous pouvez les oublier pour le moment.

NOTE

Le gizmo de la scène
Le gizmo de la scène offre un grand contrôle sur la fenêtre Scene. La figure 1.13 le montre, ce 
contrôle dispose des indicateurs X, Y et Z qui sont alignés sur les trois axes. Vous pouvez ainsi 
connaître très facilement la direction dans laquelle vous regardez la scène. Nous reviendrons sur 
les axes et l’espace 3D au cours de la session Heure 2, « Objets de jeu ». Ce gizmo permet 
également de contrôler activement l’alignement de la scène. Si vous cliquez sur l’un des axes, 
le panneau Scene bascule immédiatement dans la direction correspondante, par exemple haut 
(Top) ou gauche (Left). Un clic sur la boîte située au centre du gizmo permet de basculer entre 
les modes Iso et Persp.

Iso, abréviation de isométrique, correspond à une vue 3D dans laquelle aucune perspective 
n’est appliquée. Persp, abréviation de perspective, désigne la vue 3D en perspective. Testez ces 
paramètres et constatez leur effet sur la scène. Vous noterez que l’icône représentant le mode 
isométrique est constituée de lignes parallèles, tandis qu’elle ressemble à une patte d’oiseau 
pour l’affichage en perspective.
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	X Chaque objet de jeu est comparable à un conteneur comprenant différents composants 

(comme la caméra et l’écouteur audio présents sur la figure 1.12). Pour désactiver un 

composant, il suffit de décocher la case qui se trouve à côté ou de cliquer dessus avec 

le bouton droit de la souris et sélectionner Remove Component.

	X L’ajout de composants se fait en cliquant sur le bouton Add Component.

ATTENTION

Modifier des propriétés pendant l’exécution d’une scène
La possibilité de modifier les propriétés d’un objet et de voir ces changements se refléter 
immédiatement dans une scène en cours d’exécution se révèle très intéressante. Elle permet 
d’ajuster différents aspects à la volée, comme la vitesse d’un déplacement, la hauteur d’un saut 
ou la puissance d’une collision, sans arrêter et redémarrer le jeu. Toutefois, sachez que toutes 
les modifications effectuées sur les propriétés d’un objet pendant l’exécution d’une scène sont 
perdues à l’arrêt de celle-ci. Si vous effectuez un changement et si le résultat vous convient, 
notez-le afin de pouvoir le remettre en place lorsque la scène est terminée.

Panneau Scene
Le panneau Scene est le plus important dans Unity, car c’est là que vous pouvez consta-

ter l’évolution de la construction de votre jeu (voir figure 1.13). À l’aide de la souris et de 

quelques raccourcis clavier, vous pouvez vous déplacer au sein d’une scène et y placer des 

objets où bon vous semble. Vous disposez ainsi d’un niveau de contrôle immense.

Mode de tracé 2D/3D Effets visuels Gizmos

Éclairage Gizmo de la scène

FIGURE 1.13
Le panneau Scene.

Vous découvrirez bientôt comment vous déplacer dans une scène, mais, pour le moment, 

concentrons-nous sur les contrôles disponibles dans le panneau Scene :

	X Mode de tracé  : ce menu contrôle la manière dont la scène est dessinée. Le mode 

Shaded est sélectionné par défaut. Autrement dit, les objets sont tracés en couleurs avec 

leurs textures.

	X Vue 2D/3D : ce bouton permet de basculer entre les vues 3D et 2D. Notez que, dans 

une vue 2D, le gizmo de la scène, décrit plus loin, n’est pas visible.
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Le gizmo de la scène
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contrôle dispose des indicateurs X, Y et Z qui sont alignés sur les trois axes. Vous pouvez ainsi 
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	X Chaque objet de jeu est comparable à un conteneur comprenant différents composants 

(comme la caméra et l’écouteur audio présents sur la figure 1.12). Pour désactiver un 

composant, il suffit de décocher la case qui se trouve à côté ou de cliquer dessus avec 

le bouton droit de la souris et sélectionner Remove Component.

	X L’ajout de composants se fait en cliquant sur le bouton Add Component.

ATTENTION

Modifier des propriétés pendant l’exécution d’une scène
La possibilité de modifier les propriétés d’un objet et de voir ces changements se refléter 
immédiatement dans une scène en cours d’exécution se révèle très intéressante. Elle permet 
d’ajuster différents aspects à la volée, comme la vitesse d’un déplacement, la hauteur d’un saut 
ou la puissance d’une collision, sans arrêter et redémarrer le jeu. Toutefois, sachez que toutes 
les modifications effectuées sur les propriétés d’un objet pendant l’exécution d’une scène sont 
perdues à l’arrêt de celle-ci. Si vous effectuez un changement et si le résultat vous convient, 
notez-le afin de pouvoir le remettre en place lorsque la scène est terminée.

Panneau Scene
Le panneau Scene est le plus important dans Unity, car c’est là que vous pouvez consta-

ter l’évolution de la construction de votre jeu (voir figure 1.13). À l’aide de la souris et de 

quelques raccourcis clavier, vous pouvez vous déplacer au sein d’une scène et y placer des 

objets où bon vous semble. Vous disposez ainsi d’un niveau de contrôle immense.

Mode de tracé 2D/3D Effets visuels Gizmos

Éclairage Gizmo de la scène

FIGURE 1.13
Le panneau Scene.

Vous découvrirez bientôt comment vous déplacer dans une scène, mais, pour le moment, 

concentrons-nous sur les contrôles disponibles dans le panneau Scene :

	X Mode de tracé  : ce menu contrôle la manière dont la scène est dessinée. Le mode 

Shaded est sélectionné par défaut. Autrement dit, les objets sont tracés en couleurs avec 

leurs textures.

	X Vue 2D/3D : ce bouton permet de basculer entre les vues 3D et 2D. Notez que, dans 

une vue 2D, le gizmo de la scène, décrit plus loin, n’est pas visible.
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	X Liste déroulante des aspects : à partir de ce menu, vous pouvez choisir le rapport d’as-

pect que vous souhaitez donner à la fenêtre Game pendant l’exécution. Par défaut, le 

rapport Free Aspect est sélectionné, mais vous pouvez en changer pour correspondre au 

rapport hauteur/largeur de la plateforme pour laquelle vous développez le jeu.

	X Play Focused : ce contrôle permet d’indiquer si la fenêtre Game doit occuper l’intégra-

lité de l’éditeur lors de l’exécution. Ce n’est pas le cas par défaut et le jeu s’exécute avec 

une taille qui correspond à celle du panneau Game.

	X Mode silencieux : ce bouton désactive les sons pendant l’exécution du jeu. Il sera utile 

lorsque la personne assise à côté de vous en a assez d’entendre vos nombreux tests du jeu !

	X Stats : ce bouton détermine si les statistiques de rendu sont affichées sur l’écran pen-

dant l’exécution du jeu. Elles peuvent se révéler utiles pour mesurer l’efficacité d’une 

scène. Elles sont désactivées par défaut.

	X Gizmos : il s’agit à la fois d’un bouton et d’une liste déroulante. Le bouton détermine 

si les gizmos sont affichés pendant l’exécution du jeu, ce qui n’est pas le cas par défaut. 

Le menu déroulant (affiché en cliquant sur la flèche) permet de préciser les gizmos qui 

seront actifs.

NOTE

en cours d’exécution, suspendu et arrêté
Il n’est pas toujours facile de savoir quelles sont les conséquences associées aux termes en 
cours d’exécution, suspendu et arrêté. Lorsque l’exécution d’un jeu n’est pas en cours dans le 
panneau Game, le jeu est dit arrêté. Dans ce cas, les contrôles du jeu ne sont pas opérationnels 
et il est impossible d’y jouer. À la suite d’un clic sur le bouton Play, le jeu commence à s’exécuter 
et il est dit en cours d’exécution. Dans ce cas, un clic sur le bouton Pause stoppe l’exécution du 
jeu mais conserve son état. La différence entre un jeu suspendu et un jeu arrêté est qu’il est 
possible de reprendre l’exécution du jeu suspendu au point où il a été mis en pause, alors que 
celle d’un jeu arrêté reprend au début.

Barre d’outils
Même s’il ne s’agit pas d’un panneau, la barre d’outils est un élément essentiel de l’éditeur 

Unity. La figure 1.15 en montre les composants.

FIGURE 1.15
La barre d’outils.

	X Compte et services : ces boutons permettent de gérer votre compte Unity, ainsi que les 

services utilisés dans le projet.

	X Contrôles du panneau Game : ces boutons agissent sur le panneau Game.
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Panneau Game
Le dernier panneau que nous devons présenter est le panneau Game. Pour faire court, il per-

met de « jouer » au jeu depuis l’éditeur, en proposant une simulation complète de la scène 

courante. Tous les éléments d’un jeu sont opérationnels dans le panneau Game, tout comme 

ils le seraient si le projet était intégralement construit. La figure 1.14 montre l’aspect de ce 

panneau. Vous noterez que les boutons Play, Pause et Step sont inclus dans cette figure, même 

s’ils ne font pas techniquement partie du panneau Game, car ils en permettent le contrôle.

Liste déroulante 
des aspects Play

Pause
Step

FIGURE 1.14
Le panneau Game.

ASTUCE

Panneau Game absent
Si le panneau Game est caché par la fenêtre Scene ou si son onglet est totalement absent, ne 
vous inquiétez pas. Dès que vous cliquez sur le bouton Play, un panneau Game apparaît dans 
l’éditeur et affiche le jeu.

Le panneau Game fournit des contrôles qui aideront à tester les jeux :

	X Play : le bouton Play permet de jouer la scène courante. Tous les contrôles, animations, 

sons et effets sont présents et opérationnels. L’exécution d’un jeu dans l’éditeur doit être 

comparable à son exécution sur un lecteur indépendant, comme un PC ou un appareil 

mobile. Pour arrêter le jeu, cliquez de nouveau sur ce bouton.

	X Pause  : le bouton Pause suspend l’exécution en cours dans le panneau Game. 

Lorsqu’un jeu est en pause, il conserve son état et reste exactement comme il était au 

moment du clic sur le bouton. Un nouvel appui sur ce bouton relance l’exécution.

	X Step  : le bouton Step s’utilise lorsque l’exécution du jeu est suspendue. Il déclenche 

l’exécution d’une seule trame du jeu. Cela permet d’avancer pas à pas dans le jeu et 

de résoudre les problèmes qui pourraient exister. Un clic sur ce bouton pendant l’exé-

cution du jeu place celui-ci en pause.
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Tous les raccourcis clavier disponibles dans Unity sont décrits sur la page https://docs.

unity3d.com/Manual/SceneViewNavigation.html.

ATTENTION

Différentes caméras
Dans Unity, il existe deux types de caméras. Le premier est la caméra principale sous forme 
d’objet de jeu. Vous pouvez constater que votre scène en contient déjà une (par défaut). Le 
second type est plutôt une caméra imaginaire qu’une caméra au sens traditionnel. Il détermine 
ce que vous pouvez voir dans le panneau Scene. Dans cette section, nous faisons référence à 
une caméra du second type. Vous ne manipulez pas réellement la caméra principale.

Mode survol
Grâce au mode survol (flythrough), vous pouvez vous déplacer dans une scène selon le modèle 

classique de contrôle à la première personne. Ce mode sera familier à quiconque a déjà joué 

à des jeux à la première personne, comme certains jeux de tir. Si ce n’est pas votre cas, vous 

aurez peut-être besoin d’un peu de temps pour vous y habituer. Cependant, dès que ce sera 

fait, il deviendra une seconde nature.

Pour entrer dans le mode survol, il suffit de maintenir enfoncé le bouton droit de la souris 

pendant que son curseur se trouve dans le panneau Scene. Toutes les actions recensées dans 

le tableau 1.2 sont disponibles dans ce mode.

TABLeAu 1.2 Contrôles du mode survol

Action Effet

Déplacer la souris Fait pivoter la caméra, donnant l’impression de « regar-
der autour de soi » dans la scène.

Appuyer sur les touches WASD Les touches WASD1 permettent de se déplacer dans la 
scène, chacune correspondant à une direction : respec-
tivement en avant, vers la gauche, en arrière et vers la 
droite.

Appuyer sur les touches QE Les touches QE1 permettent un déplacement vers le 
haut et vers le bas, respectivement, dans la scène.

Appuyer sur Maj tout en appuyant 
sur les touches WASD ou QE

L’effet est le même qu’avec les touches WASD et QE, 
mais le déplacement est beaucoup plus rapide.

1. N.d.T : Les touches WASD et QE ont été choisies en raison de leur emplacement sur un clavier Qwerty. 
Elles sont moins pratiques dans le cas d’un clavier Azerty. Vous pouvez les changer en modifiant les rac-
courcis clavier à l’aide du menu Edit > Shortcuts.
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	X Liste déroulante des calques : ce menu recense les calques d’objets qui apparaissent 

dans le panneau Scene. Par défaut, tout est affiché dans la fenêtre Scene. Pour le 

moment, ne touchez à rien. Les calques seront détaillés dans la session Heure  5, 

« Éclairages et caméras ».

	X Liste déroulante des dispositions : ce menu permet de changer rapidement l’agence-

ment des composants de l’éditeur.

Naviguer dans le panneau Scene
Le panneau Scene fournit un contrôle avancé sur la construction d’un jeu. La possibilité de 

placer et de modifier visuellement des éléments se révèle très puissante. Toutefois, rien de cela 

n’est très utile s’il est impossible de se déplacer à l’intérieur de la scène. Cette section décrit 

différentes manières de changer de position et de naviguer dans le panneau Scene.

ASTUCE

Zoom
Quelle que soit la méthode employée pour la navigation, la molette de la souris effectue tou-
jours un zoom dans la scène. Par défaut, le zoom se fait à partir du centre du panneau Scene. 
Cependant, en appuyant sur la touche Alt pendant le défilement, le zoom se fait à partir de 
l’emplacement du curseur de la souris. N’hésitez pas à essayer pour voir la différence.

Outil Hand
L’outil Hand (raccourci clavier : Q), activé sur la figure 1.16, est une manière simple de se 

déplacer dans le panneau Scene à l’aide de la souris. Cet outil se révèle particulièrement utile 

lorsque vous utilisez une souris équipée d’un seul bouton, car d’autres méthodes exigent une 

sourire à deux boutons. Le tableau 1.1 décrit brièvement chaque commande de l’outil Hand. 

(Pour le moment, ne vous occupez pas des autres boutons placés à côté de l’outil Hand. Nous 

y reviendrons plus loin.)

FIGURE 1.16
L’outil Hand.

TABLeAu 1.1 Commandes de l’outil Hand

Action Effet

Cliquer-glisser Déplace la caméra dans la scène.

Appuyer sur Alt et Cliquer-glisser Fait pivoter la caméra autour du point de pivot courant.

Appuyer sur Alt (Commande sur 
Mac) et cliquer droit-glisser

Effectue un zoom de la caméra.
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en résumé
Au cours de cette session, vous avez fait vos premiers pas avec le moteur de jeu Unity. Vous 

avez tout d’abord téléchargé et installé Unity. Ensuite, vous avez appris à ouvrir et à créer des 

projets. Puis vous avez découvert les différents panneaux qui composent l’éditeur Unity. Vous 

avez également appris à vous déplacer dans le panneau Scene.

FAQ
 Q. Les ressources (assets) et les objets de jeu (game objects) désignent-il la même chose ?

 r. Pas exactement. La grande différence réside dans le fait qu’une ressource correspond 
à un fichier ou à un groupe de fichiers sur le disque dur, contrairement à un objet de 
jeu. Une ressource peut éventuellement contenir un objet de jeu.

 Q. Il existe un grand nombre de contrôles et d’options. Est-il nécessaire de les mémoriser 
dès à présent ?

 r. Absolument pas. La plupart des contrôles et des options correspondent déjà à des 
états par défaut qui couvrent la majorité des situations. Au fur et à mesure de votre 
apprentissage de Unity, vous continuerez à découvrir les différentes commandes dispo-
nibles. Cette session avait pour seul objectif de vous montrer ce qui existe et de vous 
laisser commencer à vous familiariser avec Unity.

Avez-vous bien compris ?
Prenez le temps de répondre aux questions suivantes afin de vérifier que vous maîtrisez le 
contenu de cette session.

Questions
 1. Vrai ou faux : une licence Unity Pro est nécessaire pour créer des jeux commerciaux.

 2. Quel panneau permet de manipuler visuellement des objets dans une scène ?

 3. Vrai ou faux : il faut toujours déplacer les fichiers des ressources depuis Unity plutôt 
que depuis l’explorateur de fichiers du système d’exploitation.

 4. Vrai ou faux  : la gestion des projets et des installations de Unity se fait à l’aide de 
l’éditeur.

 5. Quel est le mode sélectionné dans le panneau Scene lorsque le bouton droit de la 
souris est enfoncé ?

réponses
 1. Faux. Il est possible de créer des jeux avec la licence Unity Personal.

 2. Le panneau Scene.

 3. Vrai. Cela permet à Unity de conserver une trace des ressources.
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ASTUCE

Commandes instantanées
Il existe plusieurs manières de se déplacer précisément dans une scène. Cependant, vous pour-
riez parfois juste vouloir parcourir rapidement une scène. Dans ce cas, il est préférable d’utiliser 
ce que j’appelle les commandes instantanées. Si vous voulez aller rapidement sur un objet de jeu 
dans une scène et zoomer dessus, sélectionnez cet objet dans le panneau Hierarchy et appuyez 
sur la touche F (pour Frame Selected). La scène se focalise alors sur cet objet de jeu. Vous pou-
vez également obtenir le même résultat en double-cliquant sur n’importe quel objet du panneau 
Hierarchy. Il existe une autre commande instantanée que vous avez déjà rencontrée : le gizmo 
de la scène permet d’aligner rapidement la caméra sur un axe. Vous pouvez ainsi observer un 
objet sous n’importe quel angle sans avoir à déplacer manuellement la caméra. Prenez le temps 
de vous familiariser avec les commandes instantanées, vous naviguerez ensuite beaucoup plus 
rapidement dans une scène.

ASTUCE

ressources d’apprentissage supplémentaires
Il est possible que vous ayez déjà jeté un œil à la rubrique Learn disponible dans le Hub Unity 
(voir figure 1.17). En cliquant sur le bouton Learn, vous avez accès à des ressources d’appren-
tissage supplémentaires proposées par Unity. Elles sont d’un intérêt indéniable et, si vous 
souhaitez améliorer vos connaissances de base du moteur Unity, vous ne devez pas hésiter à 
passer du temps à les consulter. (Mon avis est un peu biaisé, car j’ai participé à leur création.)

FIGURE 1.17
La rubrique Learn du Hub Unity.
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en résumé
Au cours de cette session, vous avez fait vos premiers pas avec le moteur de jeu Unity. Vous 

avez tout d’abord téléchargé et installé Unity. Ensuite, vous avez appris à ouvrir et à créer des 

projets. Puis vous avez découvert les différents panneaux qui composent l’éditeur Unity. Vous 

avez également appris à vous déplacer dans le panneau Scene.
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apprentissage de Unity, vous continuerez à découvrir les différentes commandes dispo-
nibles. Cette session avait pour seul objectif de vous montrer ce qui existe et de vous 
laisser commencer à vous familiariser avec Unity.
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Prenez le temps de répondre aux questions suivantes afin de vérifier que vous maîtrisez le 
contenu de cette session.
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réponses
 1. Faux. Il est possible de créer des jeux avec la licence Unity Personal.
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 3. Vrai. Cela permet à Unity de conserver une trace des ressources.
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 4. Faux. La gestion des projets et des installations de l’éditeur se fait depuis le Hub Unity.

 5. Le mode survol (flythrough).

exercice
Prenez le temps de mettre en pratique les concepts décrits dans cette session. En effet, il est 
important que vous compreniez parfaitement les bases de l’éditeur Unity, car, d’une manière 
ou d’une autre, tout ce que vous apprendrez à partir de maintenant se fondera dessus. Pour 
réaliser cet exercice, effectuez les opérations suivantes :

 1. Créez une nouvelle scène en sélectionnant File > New Scene ou en appuyant sur Ctrl+N 
(Commande+N sur un Mac). Dans les modèles proposés, choisissez Basic (Built-in).

 2. Enregistrez la scène en sélectionnant File > Save ou en appuyant sur Ctrl+S 
(Commande+S sur un Mac). Prenez soin d’enregistrer la scène dans le dossier Scenes 
et donnez-lui un nom descriptif.

 3. Ajoutez un cube à la scène. Vous pouvez procéder de trois manières :

	X cliquez sur le menu GameObject placé en partie supérieure de l’éditeur et sélec-
tionnez 3D Object > Cube ;

	X cliquez sur Create > 3D Object > Cube dans le panneau Hierarchy ;

	X cliquez du bouton droit dans le panneau Hierarchy et choisissez 3D Object > Cube.

 4. Sélectionnez le cube ajouté dans le panneau Hierarchy et examinez ses propriétés dans 
le panneau Inspector.

 5. Exercez-vous à la navigation dans le panneau Scene en utilisant le mode survol, l’outil 
Hand et les commandes instantanées. Servez-vous du cube comme point de référence 
pendant votre navigation.
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